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Quick Product Overview 
	
HPV WEB/SERVER 2007 is a scalable and robust solution for viewing MPP files in a corporate 

environment. The Housatonic Project viewer supports a wide range of users and is designed to support the 

Microsoft® Project viewing (MPP files) needs of the entire project team or organization: 

 

1. Project Team members can view project information right from their desktop using any standard 

browser.  

2. Project Managers can easily publish or email project information and make it available in a matter 

of seconds to the entire project team.   

3. Executives can view project plans and get quick access to project reports, status reports and other 

critical information. 

 

Supported files format version : The following files are supported by HPV Web/Server: Microsoft Project 

files ’98, 2000, 2002, 2003 and 2007 

 

Supported Views : HPV Web/Server supports the following views: Calendar, Gantt Chart, Network Diagram, 

Task Usage, Tracking Gantt, Resource Graph, Resource Sheet, Resource Usage and customized views.  

 

Multilanguage support : HPV Web/Server is currently available in the following languages: English, French, 

German, Spanish, Italian and Japanese. If you wish to add new languages for your multinational company, 

contact the sale department for further information at: sales@projectviewercentral.com. 
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Minimum System Requirements  
	
The Operating System requirements are kept at minimum. The client workstation needs to run on a platform 

that supports one of the following browsers:  

 Internet Explorer 6.0 and higher  

 Netscape 7.1 and higher  

Most of the data processing occurs on the server so the impact on local hardware performance (memory, 

processor, hard disk space) is minimal. The following platforms were tested and certified for HPV client 

usage:  Windows 9x, Windows 2000, Windows XP, Windows 2003 and MAC OS. 

 

The following system configurations were tested and certified for HPV Server usage:  

 Microsoft Windows® 2000, Windows XP® or Windows® 2003 on a computer running with a 

Pentium IV 2.5 GHz processor and 1 Gb of RAM.  

 
Server side 
Computer/Processor 
 

Computer with Pentium 2.5 GHz or higher processor; Pentium IV recommended 

Memory 512 MB of RAM (1 Gb recommended) 
Hard Disk 20MB  

Note: The ..\Inetpub\wwwroot\ProjectViewer\Files folder is the location on your 
hard 
disk where files (such as: mpp, xml, ini or graphics) are stored as you view 
them. 

Operating System 
 

Windows NT 4.0 with Service Pack 6 (SP6) or later, Windows 2000/2003, or 
Windows XP Professional or later. 

Applications 
 

§ IIS Server v5.0 or higher§  
.NET Framework 1.1 or higher 

Display Super VGA (800 x 600) or higher-resolution monitor with 256 colors 
Peripherals 
 

Microsoft Mouse, Microsoft IntelliMouse®, or compatible pointing device 

Client side 
Computer/Processor 
 
 

Computer with Pentium 133 megahertz (MHz) or higher processor; Pentium III 
recommended 

Memory 64 MB of RAM 
Hard Disk 10MB 
Operating System Windows 98, Windows 98 Second Edition, Windows Millennium Edition 

(Windows Me), Windows 
NT 4.0 with Service Pack 6 (SP6) or later, Windows 2000, or Windows XP or 
later. 

Applications Internet Explorer 7.0 or Netscape Navigator 7.1 or higher 
Display Super VGA (800 x 600) or higher-resolution monitor with 256 colors 
Peripherals Microsoft Mouse, Microsoft IntelliMouse®, or compatible pointing device 
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Installation Guide 
	
In order to install HPV Web Server you need to perform the following steps: 
 

1. Download the Installation Kit for HPV Web/Server (i.e. HPVWeb_Trial_2007_En.zip); 

2. Unzip and run the Installation Kit file (i.e. HPVWeb_Trial_2007_En.exe); 

3. Read the License Agreement and select Accept if you want to continue; 

4. Enter your User Name and Company to match yours; If you purchased HPV Web/Server and you 
have a valid License Key you may enter this now in the Serial Number field or you may enter it later 
from the application Registration Page. 

5. Select installation path and click Next; 

6. In the IIS Configuration Page you will be able to set the site where the HPV Web/Server should be 
installed. Notice that in Windows XP and Windows 2000 Professional, you may only install the 
application in the Default Web Site as a Virtual Folder. Windows 2003 and Windows 2000 Servers 
are also able to install the application as a Virtual Folder in an existing site, but they also have the 
possibility of installing it in the root of a New Web Site.  

7. In the Email Configuration Page you may configure the email settings to be used for Send by Email 
feature of HPV Web/Server. You may also choose to configure these options later through 
administration page. 

8. Click Install and wait for setup to finalize settings; 

9. Click Finish to end the installation process. 
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 How to open and view a project file using HPV Web/ Server 
	

Generally, in HPV Web Server, you have to upload a file on a server before you can view it. In order to help 

project managers who update very often their project files, we have added a new mode of viewing the files. 

Therefore, you may use the following method to view a MPP File: 

 

Standard Open Method : Click on the Browse button located either in the default page of HPV Web Server 

or in the File/Open form, select the MPP file you want to upload and then click on View project to load the 

file in HPV Web Server. 

	

Open Subprojects : If your MPP file contains subprojects, click on the (+) sign corresponding to each 

subproject to upload them. Notice that, in the standard opening method, you will be asked to provide the 

path to the location of the MPP File. If you want to simplify the process and not be asked to locate the 

subproject each time you upload it, please relate to Method 1 from Browser Address Link Methods: copy 

both the main project (i.e. sample.mpp) and its subprojects in the C:\Program Files\Viewer Central Inc\HPV 

Web Server\Files\MPP\ folder (or the appropriate location on your server where HPV Web Server is 

installed), open Internet Explorer (or other compatible browser) and type the address: 

http://localhost/HPVWeb/Views.aspx?mppfile=sample.mpp, then click on the (+) sign corresponding to each 

subproject. The subproject will be instantly viewed. 

 

Browser Address Link Methods: 

·  Method 1: Copy the file you wish to view and update often (i.e. sample.mpp) in the C:\Program 

Files\ Viewer Central Inc \HPV Web Server\Files\MPP\ folder (or the appropriate location on your 

server where HPV Web Server is installed). Open Internet Explorer (or other compatible browser) 

and type the address: http://localhost/HPVWeb/Views.aspx?mppfile=sample.mpp. This will 

automatically view the file.  

·  Method 2: Create the folders ProjectManager1 and ProjectManager2 in the C:\Program Files\ 

Viewer Central Inc \HPV Web Server\Files\MPP\ folder. Copy the files you wish to view and update 

often (i.e. sample.mpp) according to each Project Manager into the C:\Program Files\ Viewer 

Central Inc \HPV Web Server\Files\MPP\ProjectManager1\ or C:\Program Files\ Viewer Central Inc 

\HPV Web Server\Files\MPP\ProjectyManager2\ folder (or the appropriate location on your server 

where HPV Web Server is installed). Open Internet Explorer (or other compatible browser) and 

type the address: http://localhost/HPVWeb/Views.aspx?mppfile=ProjectManager1/sample.mpp. 

This will automatically view the file. 

·  Method 3: If the file is situated on the same server or on a network path and you don't wish to move 

it into the MPP Folder, you may alternatively create a Virtual Folder in the MPP Folder in IIS, 

pointing to the file path folder (i.e. if you have the network path X:\MPPFiles\sample.mpp, you will 

create the Virtual Folder MPPFiles in /HPVWeb/Files/Mpp/ folder). Open Internet Explorer (or other 

compatible browser) and type the address: 



HPV WEB SERVER 2007 Product Guide 

www.projectviewercentral.com 

	

Page 8 of 46 �

http://localhost/HPVWeb/Views.aspx?mppfile=/MPPFiles/sample.mpp. This will automatically view 

the file. 

·  Method 4: If the file you wish to view is situated on another Internet server (i.e. 

http://www.myserver.com/files/sample.mpp) you are still able to view this file directly by opening 

Internet Explorer (or other compatible browser) and type the address: 

http://localhost/HPVWeb/Views.aspx?mppfile=http://www.myserver.com/files/sample.mpp. This will 

automatically view the file. 

�

Alternative Browser Address Link Method (using reso urce...) 

These methods can be used if you want to view a file filtered directly by a resource name (i.e. John Smith). 

These methods are particularly important because the users are able to view only the tasks assigned to 

them within a project and then, bookmark the page for further references. 

  

�  Copy the file you wish to view (i.e. sample.mpp) in the C:\Program Files\Viewer Central Inc\HPV 

Web Server\Files\MPP\ folder (or the appropriate location on your server where HPV Web Server is 

installed). Open Internet Explorer (or other compatible browser) and type the address: 

http://localhost/HPVWeb/Views.aspx?mppfile=sample.mpp&filterresourcename=JohnSmith The 

project file will be opened filtered directly by Using resource John Smith. 

If the file you want to view is a master project, make sure you have copied the master project and 

its subprojects in the MPP folder and that the option Automatically load subprojects is checked in 

the Administration page (tab General). 

or 

�  Create the folders ProjectManager1 and ProjectManager2 in the C:\Program Files\Viewer Central 

Inc\HPV Web Server\Files\MPP\ folder. Copy the files you wish to view and update often (i.e. 

sample.mpp) according to each Project Manager into the C:\Program Files\Viewer Central Inc\HPV 

Web Server\Files\MPP\ProjectManager1\ or C:\Program Files\Viewer Central Inc\HPV Web 

Server\Files\MPP\ProjectyManager2\ folder (or the appropriate location on your server where HPV 

Web Server is installed). Open Internet Explorer (or other compatible browser) and type the 

address: 

http://localhost/HPVWeb/Views.aspx?mppfile=ProjectManager1/sample.mpp&filteresourcename=J

ohnSmith 

If the file you want to view is a master project, make sure you have copied the master project and 

its subprojects in the MPP folder and that the option Automatically load subprojects is checked in 

the Administration page (tab General). 

or 

�  If the file is situated on the same server or on a network path and you don't wish to move it into the 

MPP Folder, you may alternatively create a Virtual Folder in the MPP Folder in IIS, pointing to the 

file path folder (i.e. if you have the network path X:\MPPFiles\sample.mpp, you will create the 

Virtual Folder MPPFiles in /HPVWeb/Files/Mpp/ folder). Open Internet Explorer (or other 

compatible browser) and type the address: 
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http://localhost/HPVWeb/Views.aspx?mppfile=/MPPFiles/sample.mpp&filteresourcename=JohnSmi

th 

or 

�  If the file you wish to view is situated on another Internet server (i.e. 

http://www.myserver.com/files/sample.mpp) you are still able to view this file directly by opening 

Internet Explorer (or other compatible browser) and type the address: 

http://localhost/HPVWeb/Views.aspx?mppfile=http://www.myserver.com/files/sample.mpp&filterres

ourcename=JohnSmith 

 

ODBC Method : If you have MPP files saved in a repository database (MS SQL Server, Access etc...) you 

must first create a DSN to the respective database. You may access it from HPV Web Server by selecting 

File/Open via ODBC in the menu or clicking Open via ODBC button in the toolbar, select your newly created 

DSN, provide user name and password if required by the system and select the project you want to load 

from the list. You may also configure from the Admin page the DSN that should be available to the users. 

 

MPP Folders Link Method : If you already have folders where you have placed MPP files, then you should 

use this method to allow the users to access the MPP files without being necessary to upload them first. To 

use MPP Folders Link, you need first to configure in Admin page the folders you want to share to your users. 

Then, select File/MPP Folders Link in the menu or click the MPP Folders Link button in the toolbar to display 

an Explorer like form which you may browse and select the MPP file you want to open.  

 

MS Project Central Link Method : HPV Web/Server is able to connect to a Microsoft Project Central 

Database, retrieve the list of projects and then open the selected ones. You must first configure the MSP 

Central settings through the Collaboration Options, then you may access the MS Project Central database 

by selecting File / Open MS Project Server in the menu or by clicking Open MS Project Server button in the 

toolbar. The projects available to users are set up through the Microsoft Project Central Administration page. 

Notice that MS Project Central requires authentication (either Project Central Auth or NT Auth). To use the 

NT Auth method, you must disable the Anonymous Login and enable Windows Integrated Login from IIS for 

the HPV Web/Server application. 
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How to print or email using HPV Web/Server 
 
In HPV Web/Server  application you are not only able to view MPP files, but you are also able to print or 

email them to your partners, business associates etc... Printing and emailing are easy to use and intuitive 

features. Two options are available: 

 

Print 

Send by email as PDF 

  

Print will print as PDF in a high quality and portable format preferred by most users as a powerful tool of 

printing files. Send by email enables you to send the current view to other members of your team as a PDF 

file, which they can view, print, etc... 

  

In order to print the current view, click on the corresponding icons in the toolbar or select Print from the File 

menu. You can customize the page options through the page setup form (File/Page Setup) or verify the 

printed document through the print preview form (File/Print Preview). After clicking on Print button, a PDF 

file will be generated that you can use to print or distribute. 

  

In order to send by email the current view, click on the corresponding icon in the toolbar or select Send by 

email in File menu.  The PDF file will be generated using the current page options defined in Page Setup 

form and a prompt window will be displayed where you can type the email address where you want the 

email to be sent. Notice that, in order to use this option, e-mail settings should be configured in 

Administration Page (for more information, see the chapter How to configure HPV Web/Server, section 

Admin Page.) 

�
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Detailed User Functionality 
	
1. File  

1.1 Open 
1.2 Open via ODBC 
1.3 Server Link 
1.4 Open MS Project Server 
1.5 Send by e-mail 
1.6 Page Setup 
1.7 Print Preview 
1.8 Print 
1.9 Log off 

2. Edit 
 2.1 Go To 
 2.2 Find 
 2.3 Hide column 
3. View 
 3.1 Gantt Chart 
 3.2 Tracking Gantt 
 3.3 Network Diagram 
 3.4 Task Usage 
 3.5 Resource Graph 
 3.6 Resource Sheet 
 3.7 Resource Usage 
 3.8 Calendar 
 3.9 More Views 
  3.9.1 Custom Views 
 3.10 Tables 
  3.10.1 More tables 
  3.10.2 Custom tables 
 3.11 Reports 
  3.10.1 Overview 
   3.9.1.1 Project Summary 
   3.9.1.2 Top Level Tasks 
  3.10.2 Current Activities 
   3.9.2.1 Un-started Tasks 
   3.9.2.2 Tasks in Progress 
   3.9.2.3 Completed Tasks 
 3.12 Zoom 
4. Insert 
 4.1 Columns 
5. Format 
 5.1 Appearance 
 5.2 Timescale 
6. Language 
 6.1 Select language 
7. Project 
 7.1 Sort 
 7.2 Filter 
 7.3 Show outline level 
 7.4 Project Information 
8. Collaborate 
 8.1 Collaboration Options 
Help 
 9.2 About HPV 
 9.3 Register 
10.1 Subprojects 
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1.1 Open 

 
HPV Web/Server opens Microsoft Project files ’98, Microsoft Project files 2000, Microsoft Project files 2002 

and Microsoft Project files 2003. In order to open a MPP file, you must perform the following steps: 

 

1. Select File/Open in Main Menu or click on Open icon in toolbar; 

2. In the pop-up window that is displayed, browse for the location of the MPP file you want to view; 

 

 

 

3. Select the MPP file you want to view; 

4. Click on View project button; 

5. The project file is opened with HPV Web/Server. 

 

Except the standard way of viewing a file (through File/Open), HPV Web/Server provides alternative 

methods of viewing the project files, that you can find here. 
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1.2 Open via ODBC 
 
HPV Web/Server allows opening and viewing MPP files saved in a repository database (MS SQL Server, 

Access etc...). You may access the MPP files by performing the following steps: 

 

1. Create a DSN to the database that contains the MS Projects; 

2. Select File/ Open via ODBC in the menu or click on Open via ODBC button in toolbar; 

3. In ODBC Data Source Administrator form, select the DSN that points to your project database and 

click on OK button; 

4. If the database requires authentication, provide a valid user name and password for the DSN; 

5. In the Choose project form, select the project you want to view and click on Open button. 

6. The project is opened with HPV Web Server. 

1.3 MPP Folders Link 
 
HPV Web/Server allows quick access to MPP files stored in special folders, without being necessary to 

upload them. To gain access to the respective MPP files, you must perform the following steps: 

 

1. Select File/MPP Folders Link in Main Menu or click on the MPP Folders Link button in toolbar; 

2. Navigate in MPP Folders Link form (similar to Windows Explorer) and select the MPP file you want 

to open then click on Open button; 

3. The project file is opened in HPV Web Server; 

1.4 Open MS Project Server 
 
HPV Web/Server is able to connect to a Microsoft Project Central Database, retrieve the list of projects and 

then open the selected ones. You must first configure the MS Project Central settings through the 

Collaboration Options tab, then you may access the MS Project Central database by selecting File/Open MS 

Project Server in the menu or by clicking the Open MS Project Server button in the toolbar.  

  

After selecting File/Open MS Project Server, HPV Web/Server will try to establish a communication with MS 

Project Server based on the logon information provided in Collaboration tab. If Windows User Account is 

selected to identify you with Project Server in Collaboration options, the login will be automatically made by 

the system, using your Windows account. If Microsoft Office Project Username is selected to identify you 

with Project Server in Collaboration Options, you will be asked to enter the password for the specified 

Project Server user name. To change the user name, click the General tab in this Options dialog box, and 

type a new name in the User name box. Once the connection is established, a list of projects available on 

Microsoft Project Central Server will be displayed. Select the project you want to view and click on Open. 

The project file will be opened with HPV Web/Server. 
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1.5 Send by e-mail 
 
HPV Web/Server  enables you to send by email the current view to other members of your team as a PDF 

file, which they can view, print, etc... In order to send by email the active view, you must perform the 

following steps: 

  

1. Select File/Send by email or click on Send by email button in toolbar; 

2. Type the email address where you want the file to be sent in the prompt window that is displayed; 

3. Click on Send button; 

4. The PDF file will be generated containing the current page information that is displayed in the 

application, together with the sort, filter and zoom selections that were applied and the application 

will send it to the specified email address. 

 

1.6 Page Setup 
 
The Page Setup functionality is available in the Main Menu (File/Page Setup) and in Toolbar, the Page 

Setup icon. The page setup helps you define the printing settings: 

 

Page Scaling 

Adjust to - the user can set the ratio aspect to which the printing should be performed;  

Fit to - formats the MPP file content to fit to the specified number of pages.  

Note: The paper size is calculated automatically. Adjust to and Fit to options are not available for Calendar, 

Task Usage and Resource Usage Views. 

 

Margins 

Helps you to specify the margins' width. 

 

Legend 

Every page: the legend will appear on every printed page; 

Legend page: the legend will be printed on a separately page; 

None: the legend will not be printed. 

 

View 

Print all sheet columns: Click the check box to print all sheet columns in the view. 

Print first "n" columns on each page: Use this option to print predefined columns on each page.  

Print Notes: Click the check box in order to print the notes. The notes will be printed at the end of the 

document. Note: This feature is available for Gantt Chart, Tracking Gantt, Task Sheet and Resource Sheet 

views. 

Print blank pages: check or uncheck this option to print or not the blank pages. 
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1.7 Print Preview 

 

The Print Preview functionality is available in two modes: Main Menu (File/Print Preview) or Toolbar, the 

Print Preview icon. When you click the Print Preview option a new window appears and the application 

generates the pages to be printed. The pages display the information in the exact format you set in the 

application: i.e. hidden columns, added columns, resized columns, resized panels etc. The pages follow the 

settings selected at Page Setup (paper size, margins, orientation).  

  

The Print Preview window has a dedicated Menu: 

  

Page left/Page right: view the pages from left to right; 

Page up/Page down: view the pages from top to bottom; 

Zoom icon: you can magnify or diminish the page content; 

One page icon: displays a page to fit on the screen; 

Multiple pages icon: displays multiple pages to fit on the screen; 

Print button: sends the pages content to the printer; 

Page Setup button: you can customize the appearance of the printed pages; 

Close button: closes the Print Preview and returns to the main project viewer. 

1.8 Print 
 

The Print functionality is available in two modes: Main Menu (File/Print) or Toolbar, the Print icon. By using 

this functionality the user can send the file content directly to the printer. Print opens a dialog form for 

printing the current view. 

  

Properties : opens a dialog window in which you can set printer options. This page is specific to each 

printer.  

Print range : sets the number of pages to be printed. 

Copies : sets the number of copies to be printed. 

Timescale : All - displays the entire project timespan / Dates - displays information only for the specified data 

range. Note: This option is not available for Network Diagram and Resource Sheet views. 

	

1.9 Log Off 
 

The Log Off functionality is available from the Main Menu (File/Log Off) or from the upper right corner link 

and it closes the current working session for the current user. This is mainly important to free up licenses 

more quickly. 



HPV WEB SERVER 2007 Product Guide 

www.projectviewercentral.com 

	

Page 16 of 46 �

2.1 Go To 

Because big MPP Files generate a lot of HTML content, they will take a greater amount of time to be loaded 

by the browser. By splitting the content into pages, we shorten the amount of time needed by the browser to 

load the page and also reduce the amount of memory consumption. When loading a MPP file, only the first 

page is visible: in order to view the rest of the pages, you have to select them within the Go To menu. 

 

 

 

2.2 Find 
 

Find option can be accessed either from the Main Menu (Edit/Find) or by clicking the Find icon. Enter the 

word you want to find in the document (you may specify the field you want to be searched, apply different 

constraints to the search or specify search direction), then click Find Next button.  
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3.1 Gantt Chart 
 

Gant Chart is the most popular view used by project team members. The Gantt Chart view displays task 

information in two panels: Panel 1 displays the task information as a sheet and includes details about start 

and finish task dates, resources assigned to them or % complete. The following columns are usually 

referred: Id, Indicators, Name, Duration, Start, Finish, Resource Names, Percent Complete, Predecessors. 

Panel 2 displays the Gantt bar representation of the tasks. The bar's length and position on the timescale 

indicate when that task begins and ends. In addition, the position of one task bar in relation to another 

indicates whether the tasks follow one another or overlap. 

 

	

 

Fig 1.1 Gantt Chart 
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3.2 Tracking Gantt 
 

Tracking Gantt View integrates the Gantt Chart features. In addition, it also displays the critical path and the 

baseline information. In Tracking Gantt View, tasks are represented using 2 bars displayed one on top of the 

other. If no baseline is saved only one bar is shown. The lower bar shows baseline start and finish dates, 

and the upper bar shows scheduled start and finish dates. If baseline start and finish dates are the same 

with scheduled start and finish dates then the bars are identical in size and position. If they are different then 

the bars will appear slipped from one another, the initial and final positions being delayed with the difference 

from the Scheduled Start Date and Baseline Start Date, respectively with the difference from the Scheduled 

Finish Date and Baseline Finish Date. 

 

	

 

Fig 1.2 Tracking Gantt 
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3.3 Network Diagram 
 

The Network Diagram View displays the tasks and task dependencies as a flowchart. Tasks are shown in 

geometrical blocks along with their Start, Finish, Duration and Complete Percent information (where 

available). Task dependencies are displayed with connecting arrows between the Task blocks. Red border 

suggests a critical task. 

 

	

 

Fig. 1.3 Network Diagram 

�
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3.4 Task Usage 
	

The Task Usage View is a matrix of work assignments. In a table spanned over the Project’s period, work 

loads are presented for each Task, and within it, each Resource, if any is available. 

	

�

�

Fig 1.4 Task Usage 

�
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3.5 Resource Graph 
	

The Resource Graph View displays the resource allocation information. Resources are displayed in a list. 

For each of them a 2D-barchart is shown (0x-time units, 0y-work load). The bars are colored part in blue for 

the work span within normal capacities of that resource and part in red for the over allocated work 

assignments. 

 

	

	

Fig. 1.5 Resource Graph 
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3.6 Resource Sheet 
	

The Resource Sheet view displays resource information in a sheet format. You can review information about 

each resource: Name, Type, material label, Initials, Group, Max. Units, Std. Rate, Ovt. Rate, Cost/Use, 

Accrue At, Code. 

 

Legend: Over allocated resources are shown in red color. 

	

	

	

Fig. 1.6 Resource Sheet 

�

�
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3.7 Resource Usage 

	

The Resource Usage View is a matrix of work assignments. In a table spanned over the Project’s period, 

work loads are presented for each Resource, and within it, each Task if any is available. This view is another 

side of the same aspect presented by Task Usage. 

 

	

	

Fig. 1.7 Resource Usage 
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3.8 Calendar 

	

The Calendar is the view that presents the tasks in a graphical manner on a day to day map. With blue bars 

for common tasks and black bars for milestones, tasks show their span over days or weeks. 

 

	

	

Fig. 1.8 Calendar 
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3.9 More Views 

On the View menu, click the view you want to use. To use a view that is not on the View menu, click More 

Views, click the view you want to use in the Views list, and then click Apply. 

More Views: 

1. Bar Rollup 

2. Descriptive Network Diagram 

3. Detail Gantt 

4. Leveling Gantt 

5. Milestone Dates Rollup 

6. Milestone Rollup 

7. Multiple Baselines Gantt 

8. Task Sheet 

3.9.1 Custom Views 
HPV Web Server provides the possibility to view the custom views as they were created/modified and saved 

in MS Project (including custom tables, custom fields, custom filters, text and bar styles, sorting and 

zooming, etc…) 

3.10 Tables 

HPV Web Server provides a set of tables used to show specific information about tasks, resources, and 

assignments in a sheet view.  To apply a table to the view, point to Table on the View menu and then select 

the table you want to apply. There are two types of tables: task tables (which are applied to task type views) 

and resource tables (which are applied to resource type views).  

3.10.1 More Tables 
 

To use a table that is not on the menu, click on More Tables, select the table you want to use from the list of 

available tables and then click on Apply. 

 

Task Tables 

1. Baseline 

2. Constraint Dates 

3. Cost 

4. Delay 

5. Earned Value 

6. Earned Value Cost Indicators 

7. Earned Value Schedule Indicators 

8. Entry 

9. Export 

10. Hyperlink 

Resource Tables 

1. Cost 

2. Earned Value 

3. Entry - Material Resources 

4. Entry - Work Resources  

5. Entry  

6. Export  

7. Hyperlink 

8. Summary  

9. Usage  

10. Work 
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11. Rollup  

12. Schedule  

13. Summary  

14. Tracking 

15. Usage  

16. Variance  

17. Work 

 

3.10.2 Custom Tables 
 

Users will be able, using HPV Web Server 8.5, to display customized tables as they were created / modified 

and saved in MS Project including the column width, title, header wrapping, date format etc… 

3.11 Reports 

Reports are available from the Main Menu, View/Reports option and they are used to show various Project 

situations. Reports are split into 2 categories: 

 

1. Overview  

This section displays information regarding the entire Project duration such as: 

Project Summary - This report presents a resume of the entire project. 

Top Level Tasks - This report displays a list with task information for tasks that are outlined at level 

1 in the Project. 

 

2. Current Activities 

This section displays information regarding task information such as:  

Un-started tasks - Displays a list with task information for tasks that are 0% complete (have no 

actual start date saved).  

Tasks in Progress - Displays a list with task information for tasks that have the % complete value 

between 1 and 99 (have an actual start date but no actual end date saved). 

Completed tasks - Displays a list with task information for tasks that are 100% complete (have both 

actual start and finish dates saved). 

3.12 Zoom 

Zoom is available by selecting View -> Zoom from the main menu or by clicking on the (-) or (+) buttons in 

the toolbar. The Zoom engine currently implements four levels of details: One week level (the visible unit is 

one week); Two weeks level (the visible unit is a two weeks pack); One month level (the visible unit is one 

month); One year level (the visible unit is one year).  
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4.1 Insert Columns 

Insert Columns functionality can be accessed by clicking the Columns Icon in the toolbar or via the Insert 

Menu. This feature is available for Gantt Chart, Tracking Gantt and Tasks View. Insert the columns you want 

to appear in the view by selecting them in Field Name combo-box. You may also change the columns order, 

alignment or width. 

 

You can also insert/hide columns by right-clicking on the header of the columns in the task sheet and select 

Insert or Hide Column option from the contextual menu.  

  

The columns width can be adjusted manually by dragging with the mouse, to left (in order to minimize the 

width) or right (to enlarge it) the margins of the headers in the task sheet. All the changes made in the task 

sheet related to the inserted or hidden columns, width, title alignment, etc. will be reflected in the printed 

page.  

 

 

 

5.1 Appearance 

This menu option allows choosing one of the 4 styles available in the current version of the application: 

Standard, XP Blue, XP Green and XP Silver. When choosing a style, the application will be refreshed and 

the new theme will be applied.  

5.2 Timescale 

Format Timescale option is available in the following views: Gantt Chart and Tracking Gantt. The Timescale 

helps the user to customize the layout of the chart panel. 

 

Tier formatting: Middle - refers to the first row delimiting dates in the chart panel. It can be used to change 

the display to Units like Days/Weeks/Months/Years. Bottom - refers to the second row delimiting dates in the 

chart panel. It can be used to change the display to Units like Days/Weeks/Months/Years. 



HPV WEB SERVER 2007 Product Guide 

www.projectviewercentral.com 

	

Page 28 of 46 �

 

 

 

Note: The time unit used in the Top row must be larger than the time unit used in the Bottom row. 

	

6.1 Select Language  

HPV Web Server is currently available in the following languages: English, French, German and Spanish. 

You can select one of the languages available in the combo box. Note that, for extra languages, you have to 

contact the sales department.   

 

You may change the active language of the application by selecting a language in the combo box (Select 

Language menu) and then click OK. 

7.1 Sort 

This option allows the user to sort tasks and resources by specified criteria, by controlling the order in which 

task, resource, and other information is displayed. The sort option may be accessed via the main menu from 

Project -> Sort or from the toolbar by clicking on the Sort Icon. Sort has 5 shortcuts (Sort by Start Date, by 

Finish Date, by Priority, by Cost and by ID) and one form where you may choose three sorting criteria each 

of it Ascending or Descending. 

7.2 Filter 

Filter option can be accessed in two modes: Main Menu (Project/Filter) and Toolbar, the Filter icon. The filter 

option allows the user to view a particular type of information in the project by displaying only the information 

the user is interested in and hiding the rest. If there are no filters to apply, then all the items will be taken into 

consideration. 
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7.2.1 Custom Filters 
 

HPV Web Server application provides all standard filters but also custom filters as they were defined and 

saved in MS Project for a particular file. If any of the standard or custom filters you want to use is not in the 

Project/Filtered for list, go to Project/Filtered for/More Filters and select it from the list of available filters. 

7.2.2 Highlight Filters 
 

You can view the filtered information as highlight text by setting the filter as highlight filter. In order to 

highlight a filter, go to Project/Filtered for/More Filters, select a filter in the list of available filters and then 

click on Highlight button. The tasks or resources that meet the filter’s criteria will be displayed as highlight 

(blue) text in the view. 

7.3 Show outline level 

By using the option Show outline level in the Project menu you can view either all the subtasks or the tasks 

from outline level 1 to outline level 9. 

7.4 Project Information 

The Project Information window presents general information about the Project such as: Start and Finish 

dates of the Project, Current Date is the current date read from the server where the application is hosted, 

Status date shows the date against which earned value calculations are performed, Calendar specifies the 

Project’s Calendar type and Priority indicates how readily are the resources from this project when 

competing on multiple projects. 

8.1 Collaboration Options 

On the Collaborate menu, click on tab Options and change the setting you want: 

  

Collaborate :  

Collaborate using : - Specifies whether you are using Project Central Server or not. 

Project Server URL  and Test Connection  button - Use this section to specify the URL for Project Central 

and check whether the connection to Project Server is working properly. 

  

Identification for Project Server : Use this section to set up the authentication method with Microsoft 

Project Central Server.  

  

Windows User Account - Uses current user’s credentials to authenticate with Microsoft Project Central. 

Once the user selects this type of authentication, username and password fields will be disabled as the 

application uses the current logon credentials. 

Microsoft Office Project Username - Uses the Project Server User name specified in the General tab. To 

change the user name, click the General tab in this Options dialog box, and type a new name in the User 

name box. 
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9.2 About HPV 

The About HPV menu option presents the user with a pop up window. The window displays the version of 

the product and copyright information. 

9.3 Register 

You may use this form to register the application. 

 

 

 

If you have the trial version and you purchase the application you will receive a license key. You may use 

the text box to enter the received key and then press the Accept button. After that you may close the form by 

using the "close this window" link and continue viewing MPP files. 

If you need more information about the registration process or other product information send an email to 

sales@projectviewercentral.com , call +1 413.822.5675 or visit the website www.projectviewercentral.com 

10.1 Subprojects 

The HPV Web Server can read files that refer to subproject files (a project inserted into another project). 

Subprojects are often use as a way to break complex projects into more manageable parts. Once you have 

opened the main MPP file, you can choose to expand the details of the subprojects by clicking on the (+) 

sign. 
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How to configure HPV Web/Server 
 

Administration Page 
 

HPV Web/Server is easily configurable from the Admin page that can be accessed at the location: 

http://ServerName/HPVWeb/Admin/. The Admin page is split in six tabs as follows: 

 

General  - In this tab you may configure: 

o Email settings - The email settings are used by the Send by email engine. To use this service you 

have to enter both SMTP Server (i.e. smtp.company.com) and Sender Address (i.e. 

user@company.com); 

o Automatically Load Subproject Files - if checked, this option enables opening all the subprojects 

files found in the \Files\MPP folder along with the main file. 

o Pagination settings (Maximum Tasks Displayed Per Page and Maximum Resources Displayed Per 

Page which are used by task and resource based views to split the information into separate 

pages). If the Use Pagination checkbox is unchecked then no pagination will be done on the server 

and this may cause performance decrease on big MPP files; 

o Log Off redirection (The default page where the users are redirected when they click the Log Off 

button or select File / Exit from the menu); 
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Menu - In this tab you may configure which menus are available to the users. Notice that the menus marked 

as Hide will be actually disabled. 
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Appearance  - In this tab you may configure: 

1. Default Language - The admin may set the default language that the application will use to display 

the information; the users will be able to change this setting independently within HPV Web/Server 

Application from the Select Language menu; 

2. Theme - The admin may set the default theme that the application will use; the users will be able to 

change this setting independently within HPV Web/Server Application from the Format/Appearance 

menu; 

3. Show link on top - The admin may set whether the current link is displayed or not on top of the 

application; 
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MPP Folders Link  - In this tab you may configure the shared folders that the users may access to open 

MPP files. You may add several types of location, but always include full path to the folder you want to share 

to your users. Several examples are: 

o C:\MyPath\MPPFiles 

o \\SERVER\C\MyPath\MPPFiles 

o file://C:/MyPath/MPPFiles 

Notice however that trying to share a folder from another computer requires authentication. To set up proper 

rights for the HPV Web/Server application so it will be able to access the folders and files from another 

computer, you have to modify in your Web.Config file the identity attribute from: 

<identity impersonate="false" /> 

to: 

<identity impersonate="true" userName="youruser" password="yourpassword" /> 
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ODBC - HPV Web/Server Application is able to open any Data Source Name that points to valid Project 

Repository Databases. A valid Project Repository Database it's a database created from within Microsoft 

Project, by using the Save in ODBC functionality. In this tab you may configure which System DSN should 

be available to the users. In this way, the administrator may allow access only to those DSN specified in this 

page. 
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Web.config 

Properties of HPV Web/Server can be configured either in Administration page –discussed above- or, 

manually, in web.config. Web.config is a configuration file located in the root of the Website and holds all the 

configurations of HPV Web/Server. Notice that there are configurations that are not advisable to be 

changed. Each line contains also an explanation on how and when the configuration should be used. 

 

<httpRuntime maxRequestLength="409600" /> 

<!-- Maximum size for an mpp: 400 Mb --> 

<compilation defaultLanguage="c#" debug="false" /> 

<customErrors mode="Off" /> 

<authentication mode="None" /> 

<identity impersonate="true" userName="Administrator" password="nav1gator" /> 

<authorization> 

<allow users="*" /> 

<!-- Allow all users --> 

</authorization> 

<trace enabled="false" requestLimit="10" pageOutput="false" traceMode="SortByTime" localOnly="true" /> 

<sessionState mode="InProc" stateConnectionString="tcpip=127.0.0.1:42424" sqlConnectionString="data 

source=127.0.0.1;Trusted_Connection=yes" cookieless="false" timeout="20" /> 

<globalization requestEncoding="utf-8" responseEncoding="utf-8" /> 

<appSettings> 

<!-- Application Mode is only used internally - Do Not modify it! --> 

<add key="ApplicationMode" value="HPVWEB" /> 

<!-- Used in conjuction with Application Mode - Do Not modify it! --> 

<add key="SQLConnectionString" value="" /> 

<!-- The license key to be used --> 

<add key="License_Key" value="" /> 

<!--  

Possible values: Yes / No  

- If it is set to 'Yes' then all the System DSN from the Server will be visible to the users. 

- If it is set to 'No' you must set the ODBC_ALLOWED_DSN_LIST property and add all the DSN Names to 

be allowed separated by a comma--> 

<add key="ODBC_USE" value="Yes" /> 

<!-- The list of allowed DSN Names separated by a comma. 

i.e. SQL_DSN_1,SQL_DSN_2,etc --> 

<add key="ODBC_ALLOWED_DSN_LIST" value="" /> 

<!-- Set the "SMTPServerName" property to use email functionality. --> 

<add key="SMTPServerName" value="mx.vipnet.ro" /> 

<!-- Set the "MailSender" property to use email functionality. --> 

<add key="MailSender" value="grosubogdan@vipnet.ro" /> 

<!-- Set the UrlLocation property to point to your website, machine name or IP address. 
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Please make sure you have the right URL since this may create some system errors like [Object Error] --> 

<add key="UrlLocation" value="http://localhost:81/" /> 

<!-- Set the Session timeout. This is generally usefull when having a larger number of users then the 

available number of licenses when the opened sessions must be cleared sooner to allow users to login. --> 

<!-- Notice that the value from the "timeout" atribute is expressed in minutes (default is 30) --> 

<add key="Session_Timeout" value="30" /> 

<!-- Notice that the value from the "use" attribute must be "Yes" or "No" only (default is "No") --> 

<add key="Session_UseTimeout" value="No" /> 

<add key="Pagination_Enabled" value="Yes" /> 

<add key="Pagination_TasksPageSize" value="90" /> 

<add key="Pagination_ResourcesPageSize" value="90" /> 

<!-- You can redirect to "default.aspx" or "Thanks.aspx" or any other URL like "http://www.company.com/" --

> 

<add key="LogOff_RedirectTo" value="http://www.projectviewercentral.com/" /> 

<!-- Choose from the files available in Languages folder --> 

<add key="Language" value="English" /> 

<!-- BarFormat set to enabled results in a (tracking) gantt view that is very similar to the way Ms Project 

looks like. This causes a decrease in speed --> 

<!-- BarFormat set to disabled results in a (tracking) gantt view where all the tasks are drawn using the Ms 

Project bar format defaults. The speed is noticeably better. --> 

<add key="BarFormat_Enabled" value="Yes" /> 

<!-- Possible values are: XPSilver, XPBlue, XPGreen, Standard --> 

<add key="Theme" value="XPBlue" /> 

<!-- Automatically Load Subproject Files found in the \Files\MPP folder --> 

<add key="LoadSubprojects" value="Yes" /> 

<!-- Show link to mpp file on top, below the Project Name --> 

<add key="ShowLinkOnTop" value="No" /> 

<!-- Show Title --> 

<add key="ShowTitle" value="Yes" /> 

<!-- Show Menu --> 

<add key="ShowMenu" value="Yes" /> 

<!-- Show Toolbar --> 

<add key="ShowToolbar" value="Yes" /> 

<!-- Show ViewBar --> 

<add key="ShowViewBar" value="Yes" /> 

<!-- This setting is telling Resource Usage View whether to merge the Resources with the same name - 

value 'true' / 'false' --> 

<add key="ResourceUsage_MergeResources" value="false" /> 

<!-- The number of detail weeks displayed in Resource Usage - value may range between 1 and 4 --> 

<add key="ResourceUsage_NumberOfWeeksDisplayed" value="2" /> 
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<!-- This setting is telling Resource Usage View whether to display the current server date week for details - 

value 'true' / 'false' --> 

<add key="ResourceUsage_DisplayCurrentDateWeek" value="false" /> 

<!-- This setting is telling Resource Usage View whether to display or not the Unassigned groups when 

using FilterResourceName parameter - value 'true' / 'false' --> 

<add key="ResourceUsage_ShowUnassigned_FilterResourceName" value="true" /> 

<!-- This setting is telling Resource Usage View whether to use or not hierarchical display for tasks - value 

'true' / 'false' --> 

<add key="ResourceUsage_UseHierarchicalDisplay" value="false" /> 

<!-- Set server link folders : c:\folder, file://c:\folder, \\server\folder --> 

<add key="ServerLink1" value="\\SERVER\folder" /> 

<!-- Microsoft Project Central Settings --> 

<!-- Microsoft Project Central - Link --> 

<add key="MSPCentral_Link" value="http://SERVER/ProjectServer/" /> 

<!-- Microsoft Project Central - Connection String to its Database --> 

<add key="MSPCentral_Connection" value="Driver={SQL 

Server};Server=SERVER;Database=ProjectServer;Uid=mspc;Pwd=mspc;" /> 

<!-- Print Optimization --> 

<add key="PrintOptimization" value="Yes" /> 

<!-- Print jobs - Max count --> 

<add key="MaxPrintJobs" value="2" /> 

<!-- Default print pages --> 

<add key="DefaultPrintPages" value="25" /> 

<!-- Menus / Toolbar buttons Availability --> 

<add key="kFile" value="true" /> 

<add key="kFile_Open" value="true" /> 

<add key="kFile_ODBC" value="true" /> 

<add key="kFile_ServerLink" value="true" /> 

<add key="kFile_MSPC" value="true" /> 

<add key="kFile_SendByEmail" value="true" /> 

<add key="kFile_PageSetup" value="true" /> 

<add key="kFile_PrintPreview" value="true" /> 

<add key="kFile_Print" value="true" /> 

<add key="kFile_Exit" value="true" /> 

<add key="kEdit" value="true" /> 

<add key="kEdit_GoTo" value="true" /> 

<add key="kEdit_Find" value="true" /> 

<add key="kView" value="true" /> 

<add key="kView_MoreViews" value="true" /> 

<add key="kView_Table" value="true" /> 

<add key="kView_Table_More" value="true" /> 
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<add key="kView_Reports" value="true" /> 

<add key="kView_Zoom" value="true" /> 

<add key="kInsert" value="true" /> 

<add key="kInsert_Column" value="true" /> 

<add key="kSelectLanguage" value="true" /> 

<add key="kFormat" value="true" /> 

<add key="kFormat_Appearance" value="true" /> 

<add key="kFormat_Appearance_XPBlue" value="true" /> 

<add key="kFormat_Appearance_XPSilver" value="true" /> 

<add key="kFormat_Appearance_XPGreen" value="true" /> 

<add key="kFormat_Appearance_Standard" value="true" /> 

<add key="kFormat_Timescale" value="true" /> 

<add key="kProject" value="true" /> 

<add key="kProject_Sort" value="true" /> 

<add key="kProject_Sort_StartDate" value="true" /> 

<add key="kProject_Sort_FinishDate" value="true" /> 

<add key="kProject_Sort_Priority" value="true" /> 

<add key="kProject_Sort_Cost" value="true" /> 

<add key="kProject_Sort_ID" value="true" /> 

<add key="kProject_Sort_Name" value="true" /> 

<add key="kProject_Sort_SortBy" value="true" /> 

<add key="kProject_Filter" value="true" /> 

<add key="kProject_Filter_More" value="true" /> 

<add key="kProject_Show" value="true" /> 

<add key="kProject_Information" value="true" /> 

<add key="kTools_Options_Collaborate" value="true" /> 

<add key="kFRMCentralInfo_Collaboration_Options" value="true" /> 

<add key="kHelp" value="true" /> 

<add key="kHelp_HPVHelp" value="true" /> 

<add key="kHelp_Register" value="true" /> 

<add key="kHelp_About" value="true" /> 
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Integration of HPV Web/Server with MS Share Point 
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HPV Web/Server is also able to open and display MPP files located on various websites. In order to 

integrate HPV Web/Server with the websites that hold the MPP files, the following steps are required:  

 

1. Install HPV Web/Server on a Server; 

2. Upload the MPP Files on the Website; 

3. Create links that point to the uploaded mpp files in a HTML page by passing the mpp file names as 

a URL parameter following this example:  

 

        http://localhost/HPVWeb/Views.aspx?mppfile=proiectdemo.mpp 

 

4. Open the created HTML page in a browser;  

5. Click on one of the links to view Project Information using HPV Web/Server; 
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Basic Troubleshooting Techniques 
 

I have installed HPV Web on my Windows 2003 Server, it did installed successfully, I have 
opened the site, but when I try to view a MPP File I get the error: The page cannot be displayed. 
 

1. Open Add/Remove Programs from Settings / Control Panel 

2. Click on Add/Remove Windows Components 

3. Check if  Application Server / ASPNet Component is installed 

4. If it isn’t , install it and verify again if the HPV Web Server application works properly 

5. If the error still persists, open IIS, go to Web Service Extensions, check if ASP.Net v1.1.4322 has 

the status Allowed 

6. If the status is Prohibited, click on the Allow button 

Following the steps above should fix the error. 
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